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package ui; 

a.awt.event.ActionListener; 
ax.swing.JDialog; 

javax.swing.JFrame; 

lass About extends JDialog { 

  /** Creates new form About */ 
  public About(JFrame parent) { 
      super(parent,true); 
      initComponents(); 
      pack(); 
      Rectangle parentBounds = parent.getBounds(); 
      Dimension size = getSize(); 
      // Center in the parent 
      int x = Math.max(0, parentBounds.x + (parentBounds.width - 
ze.width) / 2); 
      int y = Math.max(0, parentBounds.y + (parentBounds.height - 
ze.height) / 2); 
      setLocation(new Point(x, y)); 
  } 

  /** This method is called from within the constructor to 
   * initialize the form. 
   * WARNING: Do NOT modify this code. The content of this method 
 
   * always regenerated by the Form Editor. 
   */ 
  // <editor-fold defaultstate="collapsed" desc=" Generated Code 
//GEN-BEGIN:initComponents 
  private void initComponents() { 
      java.awt.GridBagConstraints gridBagConstraints; 

      mainPanel = new javax.swing.JPanel(); 
      copyrightTextArea = new javax.swing.JTextArea(); 
      closeButton = new javax.swing.JButton(); 

      getContentPane().setLayout(new java.awt.GridBagLayout()); 

      
tDefaultCloseOperation(javax.swing.WindowConstants.DISPOSE_ON_CLOSE
 
      setTitle("About Bluetooth Bus Info"); 
      mainPanel.setLayout(new java.awt.GridBagLayout()); 

      
inPanel.setBorder(javax.swing.BorderFactory.createEmptyBorder(11, 
, 12, 12)); 
      
pyrightTextArea.setBackground(javax.swing.UIManager.getDefaults().g
Color("Panel.background")); 
      copyrightTextArea.setColumns(25); 
      copyrightTextArea.setEditable(false); 
      copyrightTextArea.setLineWrap(true); 
      copyrightTextArea.setRows(8); 

 
import java.awt.Dimension; 

.Point; import java.awt
import java.awt.Rectangle; 
import jav
import jav
import 
 
public c
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        copyrightTextArea.setText("Bluetooth Bus Info\n\nAuthor: Mohd 
ws\nOrganization: 

ue); 
Border(null); 

      copyrightTextArea.setFocusable(false); 
traints(); 

.fill = java.awt.GridBagConstraints.BOTH; 
anchor = 

ts.NORTH; 

raints.insets = new java.awt.Insets(24, 0, 24, 

agConstraints); 

closeButton.setText("Close"); 

ent.ActionListener() { 
public void actionPerformed(java.awt.event.ActionEvent 

tionPerformed(evt); 

 0; 
= 1; 

onstraints.anchor = 
AST; 
, gridBagConstraints); 

ridBagConstraints = new java.awt.GridBagConstraints(); 
fill = java.awt.GridBagConstraints.BOTH; 

Constraints.weighty = 1.0; 
tentPane().add(mainPanel, gridBagConstraints); 

// </editor-fold>//GEN-END:initComponents 

e void 
nEvent evt) {//GEN-

tVisible(false); 
 dispose(); 
/GEN-LAST:event_closeButtonActionPerformed 

not modify//GEN-BEGIN:variables 
  private javax.swing.JButton closeButton; 

opyrightTextArea; 
nPanel; 

End of variables declaration//GEN-END:variables 

Suhkri Yasri\nLanguage: Java\nPlatform: Windo
Unimap"); 

tArea.setWrapStyleWord(tr        copyrightTex
        copyrightTextArea.set
  
        gridBagConstraints = new java.awt.GridBagCons
        gridBagConstraints
        gridBagConstraints.
java.awt.GridBagConstrain
        gridBagConstraints.weightx = 1.0; 
        gridBagConstraints.weighty = 1.0; 
        gridBagConst
0); 
        mainPanel.add(copyrightTextArea, gridB
 
        closeButton.setMnemonic('C'); 
        
        closeButton.addActionListener(new 
java.awt.ev
            
evt) { 
                closeButtonAc
            } 
        }); 
 
        gridBagConstraints = new java.awt.GridBagConstraints(); 
        gridBagConstraints.gridx =

BagConstraints.gridy         grid
        gridBagC
java.awt.GridBagConstraints.SOUTHE

mainPanel.add(closeButton        
 
        g
        gridBagConstraints.
        gridBagConstraints.weightx = 1.0; 
        gridBag

tCon        ge
 
    }
 
    privat
closeButtonActionPerformed(java.awt.event.Actio

ormed FIRST:event_closeButtonActionPerf
        se
       
  }/  

 
 

Variables declaration - do     // 
  
    private javax.swing.JTextArea c

JPanel mai    private javax.swing.
    // 
 
} 
 
 
 
 
 

  



package ui; 
 
import javax.swing.table.AbstractTableModel; 

ends AbstractTableModel { 

gno","Origin","Time 

ResultSets; 

) { 

 ArrayList<String[]>();   

    try{ 

        String[] row={ 

tring("acompany"), 
,aa.getString("origin"),aa.getString("timearriv

   

      System.out.println("Exception in CarTableModel"); 

ndex) { 

import java.sql.*; 
import java.util.ArrayList; 
 
public class ATableModel ext
     
    private int colnum=6; 
    private int rownum; 
    private String[] colNames={ 
        "BluetoothID","Company","Re
Arrive","Platform" 
    }; 
    private  ArrayList<String[]> 
     
    public ATableModel(ResultSet aa
       
      ResultSets=new
     
  
        while(aa.next()){ 
       
      
                
aa.getString("abluetoothID"),aa.getS
aa.getString("aregno")
e"),aa.getString("platform") 
           
            }; 
            ResultSets.add(row); 
       
         } 
      } 

atch(Exception e){       c
    
            } 
         
    } 
    

t columni    public Object getValueAt(int rowindex, in
         
       String[] row=ResultSets.get(rowindex); 
       return row[columnindex]; 
         
    } 
 
    public int getRowCount() { 
        return ResultSets.size(); 
    } 
 
    public int getColumnCount() { 
        return colnum; 
    } 
 
    public String getColumnName(int param) { 
 
       return colNames[param]; 
    } 
     
} 

  



package ui; 
 
import java.sql.*; 
 
public class MyDBConnection { 
    
    private Connection myConnection; 
    private MyDBConnection mdbc; 
    private java.sql.Statement stmt; 
     
    /** Creates a new instance of MyDBConnection */ 
    public MyDBConnection() { 
 
    } 
 
    public void init(){ 
     
       try{ 
         
        Class.forName("com.mysql.jdbc.Driver"); 
        myConnection=DriverManager.getConnection( 

ot", "qwerty" 

on"); 

){ 

                "jdbc:mysql://localhost/bluetooth","ro
                ); 
        } 
        catch(Exception e){ 
            System.out.println("Failed to get connecti
            e.printStackTrace(); 
        } 
    } 
     
     
    public Connection getMyConnection(){ 
        return myConnection; 
    } 
     
     
    public void close(ResultSet rs){ 
         
        if(rs !=null){ 
            try{ 
               rs.close(); 
            } 
            catch(Exception e){} 
         
        } 
    } 
     
     public void close(java.sql.Statement stmt
         
        if(stmt !=null){ 
            try{ 
               stmt.close(); 
            } 
            catch(Exception e){} 
         
        } 
    } 
      
  public void destroy(){ 
   
    if(myConnection !=null){ 

  



     
         try{ 
               myConnection.close(); 
            } 
            catch(Exception e){} 
         
         
    } 
  } 
       
} 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  



package ui; 
 
import javax.swing.table.AbstractTableModel; 

ass scanTable extends AbstractTableModel { 

  private int rownum; 

ets=new ArrayList<String[]>();   

 

ing[] row={ 

,rs.getString("timed

 int columnindex) { 

Sets.size(); 

tColumnCount() { 

import java.sql.*; 
import java.util.ArrayList; 
 
public cl
     
    private int colnum=6; 
  
    private String[] colNames={ 
        "BluetoothID","Company","Regno","Destination","Time 
Depart","Platform" 
    }; 
    private  ArrayList<String[]> ResultSets; 
     
    public scanTable(ResultSet rs) { 
       
      ResultS
     
      try{
        while(rs.next()){ 
       
              Str
                rs.getString("dbluetoothID"), 
rs.getString("company"), 
rs.getString("regno"),rs.getString("destination")
epart"),rs.getString("platform") 
           
            }; 
            ResultSets.add(row); 
       
         }    
      } 
      catch(Exception e){ 
          System.out.println("Exception in CarTableModel"); 
            } 
         
    } 
    
    public Object getValueAt(int rowindex,
         
       String[] row=ResultSets.get(rowindex); 
       return row[columnindex]; 
         
    } 
 
    public int getRowCount() { 
        return Result
    } 
 
    public int ge
        return colnum; 
    } 
 
    public String getColumnName(int param) { 
 
       return colNames[param]; 
    } 
     
} 

  



package ui; 
 
import ja
import java.util.Calendar; 
import javax.swing.J

va.awt.event.KeyEvent; 

port java.awt.event.KeyEvent; 

port javax.swing.JFrame; 

avax.swing.SwingUtilities; 

UI; 

blic class UI extends javax.swing.JFrame implements 

mdbc.init(); 
 

tmt= conn.createStatement(); 
      } catch (SQLException ex) { 

ng.JTabbedPane(); 
Panel(); 

 = new javax.swing.JScrollPane(); 
; 

vax.swing.JPanel(); 

a(); 

 

edPane(); 

        jButton4 = new javax.swing.JButton(); 

TextArea; 
import java.awt.BorderLayout; 
import java.awt.Dimension; 
import java.awt.event.KeyAdapter; 
im
import java.util.Calendar; 
 
import javax.swing.BorderFactory; 
im
import javax.swing.JPanel; 
import javax.swing.JScrollPane; 
import javax.swing.JTextArea; 
import javax.swing.JTextField; 
import j
import java.sql.*; 
import ui.Swing
 
pu
ConnectionProtocol.EventHandler { 
     
    public UI() { 
        mdbc=new MyDBConnection(); 
        
        Connection conn=mdbc.getMyConnection();
        try { 
            s
  
            ex.printStackTrace(); 
        } 
        initComponents(); 
    } 
   
    // <editor-fold defaultstate="collapsed" desc=" Generated Code 
">//GEN-BEGIN:initComponents 
    private void initComponents() { 
        jTabbedPane1 = new javax.swi

 new javax.swing.J        jPanel1 =
        jPanel12 = new javax.swing.JPanel(); 
        jScrollPane1
        jTextArea1 = new javax.swing.JTextArea()
        jScrollPane2 = new javax.swing.JScrollPane(); 
        jTextArea2 = new javax.swing.JTextArea(); 
        jLabel1 = new javax.swing.JLabel(); 
        jLabel2 = new javax.swing.JLabel(); 
        jPanel14 = new ja
        jScrollPane5 = new javax.swing.JScrollPane(); 
        jTextArea3 = new javax.swing.JTextAre
        jScrollPane6 = new javax.swing.JScrollPane(); 

JTextArea();         jTextArea4 = new javax.swing.
        jTextField1 = new javax.swing.JTextField(); 
        jTextField2 = new javax.swing.JTextField(); 
        jButton1 = new javax.swing.JButton(); 
        jButton2 = new javax.swing.JButton();
        jPanel2 = new javax.swing.JPanel(); 
        jTabbedPane2 = new javax.swing.JTabb
        jPanel4 = new javax.swing.JPanel(); 

  



        jButton5 = new javax.swing.JButton(); 
        jPanel5 = new javax.swing.JPanel(); 
        jLabel3 = new javax.swing.JLabel(); 
        jTextField4 = new javax.swing.JTextField
        jLabel4 = new javax.swing.JLabel(); 

(); 

bel(); 
tField5 = new javax.swing.JTextField(); 

tField(); 
l6 = new javax.swing.JLabel(); 

 new javax.swing.JLabel(); 

w javax.swing.JPanel(); 

d25 = new javax.swing.JTextField(); 

= new javax.swing.JTextField(); 

extField(); 
el(); 
extField(); 

n(); 
l(); 

); 
= new javax.swing.JLabel(); 

w javax.swing.JButton(); 
 
ane(); 

le1 = new javax.swing.JTable(); 
nel8 = new javax.swing.JPanel(); 

 
Panel(); 

; 
; 

l18 = new javax.swing.JLabel(); 

Label20 = new javax.swing.JLabel(); 

ng.JTextField(); 
d16 = new javax.swing.JTextField(); 

Field(); 
ield(); 
); 

 
        jLabel24 = new javax.swing.JLabel(); 

        jLabel5 = new javax.swing.JLa
        jTex
        jTextField6 = new javax.swing.JTex
        jLabe
        jLabel7 = new javax.swing.JLabel(); 
        jTextField7 = new javax.swing.JTextField(); 
        jTextField8 = new javax.swing.JTextField(); 
        jLabel8 =
        jTextField29 = new javax.swing.JTextField(); 
        jPanel3 = ne
        jPanel6 = new javax.swing.JPanel(); 
        jLabel11 = new javax.swing.JLabel(); 
        jLabel10 = new javax.swing.JLabel(); 
        jTextField9 = new javax.swing.JTextField(); 
        jTextField10 = new javax.swing.JTextField(); 
        jLabel9 = new javax.swing.JLabel(); 
        jTextFiel
        jLabel29 = new javax.swing.JLabel(); 
        jTextField26 
        jLabel30 = new javax.swing.JLabel(); 
        jTextField27 = new javax.swing.JT
        jLabel31 = new javax.swing.JLab
        jTextField28 = new javax.swing.JT
        jButton3 = new javax.swing.JButton(); 
        jButton6 = new javax.swing.JButto
        jPanel7 = new javax.swing.JPane
        jLabel12 = new javax.swing.JLabel(
        jLabel13 
        jLabel14 = new javax.swing.JLabel(); 

d11 = new javax.swing.JTextField();         jTextFiel
        jTextField12 = new javax.swing.JTextField(); 
        jButton7 = ne
        jButton8 = new javax.swing.JButton();
        jScrollPane3 = new javax.swing.JScrollP
        jTab
      jPa  

        jTabbedPane3 = new javax.swing.JTabbedPane();
        jPanel9 = new javax.swing.J
        jLabel16 = new javax.swing.JLabel()
        jLabel17 = new javax.swing.JLabel()
        jLabe
        jLabel19 = new javax.swing.JLabel(); 
        j
        jLabel21 = new javax.swing.JLabel(); 
        jTextField14 = new javax.swing.JTextField(); 
        jTextField15 = new javax.swi
        jTextFiel
        jTextField17 = new javax.swing.JTextField(); 
        jTextField18 = new javax.swing.JText
        jTextField19 = new javax.swing.JTextF
        jButton11 = new javax.swing.JButton(
        jButton12 = new javax.swing.JButton(); 
        jPanel10 = new javax.swing.JPanel(); 
        jPanel13 = new javax.swing.JPanel(); 
        jLabel23 = new javax.swing.JLabel();

  



        jTextField20 = new javax.swing.
        jTextField21 = new javax.swing.JTextField(); 

JTextField(); 

abel(); 
Label(); 

(); 
l34 = new javax.swing.JLabel(); 

JTextField(); 
on(); 

tton(); 

(); 
extField(); 

JTextField(); 
n(); 

      jTable2 = new javax.swing.JTable(); 

ew javax.swing.JScrollPane(); 
TextArea(); 

TextField13 = new javax.swing.JTextField(); 

.JLabel(); 
on(); 
el(); 

jTextArea6 = new javax.swing.JTextArea(); 
ld(); 

6 = new javax.swing.JLabel(); 
Field34 = new javax.swing.JTextField(); 
el35 = new javax.swing.JLabel(); 

n(); 
uBar(); 
); 

jMenu2 = new javax.swing.JMenu(); 
); 

oseOperation(javax.swing.WindowConstants.EXIT_ON_CLOSE); 
ddWindowListener(new java.awt.event.WindowAdapter() { 

vt) 

          } 

TitledBorder("")); 

anel12.setBorder(javax.swing.BorderFactory.createTitledBorder("Blue

        jLabel22 = new javax.swing.JL
el32 = new javax.swing.J        jLab

        jLabel33 = new javax.swing.JLabel
        jLabe
        jTextField3 = new javax.swing.JTextField(); 
        jTextField30 = new javax.swing.JTextField(); 
        jTextField31 = new javax.swing.JTextField(); 
        jTextField32 = new javax.swing.
        jButton13 = new javax.swing.JButt
        jButton14 = new javax.swing.JBu
        jPanel11 = new javax.swing.JPanel(); 
        jLabel25 = new javax.swing.JLabel(); 
        jLabel26 = new javax.swing.JLabel(); 
        jLabel27 = new javax.swing.JLabel
        jTextField22 = new javax.swing.JT
        jTextField23 = new javax.swing.
        jButton15 = new javax.swing.JButto
        jButton16 = new javax.swing.JButton(); 
        jScrollPane4 = new javax.swing.JScrollPane(); 
  
        jPanel15 = new javax.swing.JPanel(); 
        jPanel16 = new javax.swing.JPanel(); 
        jScrollPane7 = n
        jTextArea5 = new javax.swing.J
        j
        jTextField33 = new javax.swing.JTextField(); 
        jLabel15 = new javax.swing.JLabel(); 
        jLabel28 = new javax.swing
        jButton9 = new javax.swing.JButt
        jPanel17 = new javax.swing.JPan
        jScrollPane8 = new javax.swing.JScrollPane(); 
        
        jTextField24 = new javax.swing.JTextFie
        jLabel3
        jText
      jLab  

        jButton10 = new javax.swing.JButto
        jMenuBar1 = new javax.swing.JMen
        jMenu1 = new javax.swing.JMenu(
        jMenuItem1 = new javax.swing.JMenuItem(); 
        
        jMenuItem2 = new javax.swing.JMenuItem(
 
        
tDefaultClse

        a
            public void windowClosing(java.awt.event.WindowEvent e
{ 
                formWindowClosing(evt); 
  
        }); 
 
        
anel1.setBorder(javax.swing.BorderFactory.createjP

        
jP
tooth Devices")); 
        jTextArea1.setColumns(20); 
        jTextArea1.setRows(5); 

  



        jScrollPane1.setViewportView(jTextArea1); 

rea2); 

NTER); 

Text("Time and Date Detected"); 

ut = new 

roup(jPanel12Layout.createSequentialGroup() 

ax.swing.GroupLayout.

ax.swing.GroupLayout.

bel2, 
, 255, Short.MAX_VALUE)) 

   
ignment.

roup(javax.swing.GroupLayout.Alignment.TRAILING, 

(javax.swing.GroupLayout.

l2)) 

ComponentPlacement.RELATED) 

2Layout.createParallelGroup(javax.swing.GroupLayout.

ne2, 
hort.MAX_VALUE) 

, Short.MAX_VALUE)) 
                .addContainerGap()) 

 
        jTextArea2.setColumns(20); 
        jTextArea2.setRows(5); 
        jScrollPane2.setViewportView(jTextA
 
        
jLabel1.setHorizontalAlignment(javax.swing.SwingConstants.CE
        jLabel1.setText("Bluetooth Address"); 
 
        
jLabel2.setHorizontalAlignment(javax.swing.SwingConstants.CENTER); 
        jLabel2.set
 
        javax.swing.GroupLayout jPanel12Layo
javax.swing.GroupLayout(jPanel12); 
        jPanel12.setLayout(jPanel12Layout); 
        jPanel12Layout.setHorizontalGroup( 
            
jPanel12Layout.createParallelGroup(javax.swing.GroupLayout.Alignment.
LEADING) 
            .addG
                .addContainerGap() 
                
.addGroup(jPanel12Layout.createParallelGroup(jav
Alignment.LEADING) 
                    .addComponent(jScrollPane1, 
javax.swing.GroupLayout.DEFAULT_SIZE, 250, Short.MAX_VALUE) 
                    .addComponent(jLabel1, 
javax.swing.GroupLayout.DEFAULT_SIZE, 250, Short.MAX_VALUE)) 
                .addGap(20, 20, 20) 
                
.addGroup(jPanel12Layout.createParallelGroup(jav
Alignment.TRAILING) 
                    .addComponent(jScrollPane2, 
javax.swing.GroupLayout.DEFAULT_SIZE, 255, Short.MAX_VALUE) 
                    .addComponent(jLa

GroupLayout.DEFAULT_SIZEjavax.swing.
                .addContainerGap()) 
        ); 
        jPanel12Layout.setVerticalGroup( 
         
jPanel12Layout.createParallelGroup(javax.swing.GroupLayout.Al
LEADING) 
            .addG
jPanel12Layout.createSequentialGroup() 
                
.addGroup(jPanel12Layout.createParallelGroup
Alignment.BASELINE) 
                    .addComponent(jLabel1) 
                    .addComponent(jLabe
                

javax.swing.LayoutStyle..addPreferredGap(
                
.addGroup(jPanel1
Alignment.LEADING) 
                    .addComponent(jScrollPa
javax.swing.GroupLayout.DEFAULT_SIZE, 173, S
                    .addComponent(jScrollPane1, 
javax.swing.GroupLayout.DEFAULT_SIZE, 173

  



        ); 
 
        
jPanel14.setBorder(javax.swing.BorderFactory.createTitledBorder("Buss
es Information")); 
        jTextArea3.setColumns(20); 
        jTextArea3.setRows(5); 

); 

Area4); 

tionListener() { 

; 

tion"); 
addActionListener(new 

tton2ActionPerformed(evt); 

out(jPanel14); 

x.swing.GroupLayout.Alignment.

(jPanel14Layout.createSequentialGroup() 

ax.swing.GroupLayout.

56, Short.MAX_VALUE) 
t.createSequentialGroup() 
ollPane6, 

GroupLayout.DEFAULT_SIZE, 256, Short.MAX_VALUE) 
                      

cement.RELATED)) 
Button2, 

Short.MAX_VALUE)) 

AILING, 
E, 

        jScrollPane5.setViewportView(jTextArea3
 
        jTextArea4.setColumns(20); 
        jTextArea4.setRows(5); 
        jScrollPane6.setViewportView(jText
 
        jButton1.setText("Departure Information"); 
        jButton1.addActionListener(new 
java.awt.event.Ac
            public void actionPerformed(java.awt.event.ActionEvent 
evt) { 
                jButton1ActionPerformed(evt)
            } 
        }); 
 
        jButton2.setText("Arriving Informa
        jButton2.
java.awt.event.ActionListener() { 
            public void actionPerformed(java.awt.event.ActionEvent 
evt) { 
                jBu
            } 
        }); 
 
        javax.swing.GroupLayout jPanel14Layout = new 
javax.swing.GroupLay
        jPanel14.setLayout(jPanel14Layout); 
        jPanel14Layout.setHorizontalGroup( 
            
jPanel14Layout.createParallelGroup(java
LEADING) 
            .addGroup
                .addContainerGap() 
                
.addGroup(jPanel14Layout.createParallelGroup(jav
Alignment.LEADING) 
                    .addComponent(jTextField1, 
javax.swing.GroupLayout.DEFAULT_SIZE, 2
                    .addGroup(jPanel14Layou

(jScr                        .addComponent
javax.swing.
  
.addPreferredGap(javax.swing.LayoutStyle.ComponentPla
                    .addComponent(j
javax.swing.GroupLayout.DEFAULT_SIZE, 256, 
                .addGap(14, 14, 14) 
                
.addGroup(jPanel14Layout.createParallelGroup(javax.swing.GroupLayout.
Alignment.LEADING, false) 
                    .addComponent(jButton1, 
javax.swing.GroupLayout.Alignment.TR

Layout.DEFAULT_SIZjavax.swing.Group
javax.swing.GroupLayout.DEFAULT_SIZE, Short.MAX_VALUE) 

  



                    .
javax.swing.GroupLayout.Alignment.TRAILING) 
                    .addComponent(jScro

addComponent(jTextField2, 

llPane5, 

t.Alignment.

.addGroup(jPanel14Layout.createSequentialGroup() 

           .addComponent(jScrollPane6, 

lPane5, 
, Short.MAX_VALUE)) 

ComponentPlacement.RELATED) 

E) 

 

vax.swing.GroupLayout.DEFAULT_SIZE, 
ng.GroupLayout.PREFERRED_SIZE)) 

ax.swing.LayoutStyle.ComponentPlacement.RELATED) 

ut.

                  .addComponent(jButton1))) 

 
vax.swing.GroupLayout(jPanel1); 

      jPanel1Layout.setHorizontalGroup( 

oupLayout.Alignment.L

          .addGroup(javax.swing.GroupLayout.Alignment.TRAILING, 

(javax.swing.GroupLayout.A

, Short.MAX_VALUE) 
Panel14, 

javax.swing.GroupLayout.Alignment.TRAILING, 
javax.swing.GroupLayout.DEFAULT_SIZE, 255, Short.MAX_VALUE)) 
                .addContainerGap()) 
        ); 
        jPanel14Layout.setVerticalGroup( 
            
jPanel14Layout.createParallelGroup(javax.swing.GroupLayou
LEADING) 
            
                
.addGroup(jPanel14Layout.createParallelGroup(javax.swing.GroupLayout.
Alignment.LEADING) 
         
javax.swing.GroupLayout.DEFAULT_SIZE, 217, Short.MAX_VALUE) 
                    .addComponent(jScrol
javax.swing.GroupLayout.DEFAULT_SIZE, 217
                
.addPreferredGap(javax.swing.LayoutStyle.
                
.addGroup(jPanel14Layout.createParallelGroup(javax.swing.GroupLayout.
Alignment.BASELIN
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 Class.forName("com.mysql.jdbc.Driver").newInstance(); 
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           String username = "root"; 
           String password = "qwerty"; 
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      ResultSet rs = stmt.executeQue
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             con.close(); 
 
           } 
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           // on localhost. 
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     // moving forward in the result set: 
     while (rs.next()) { 

                 String Company = rs.getString("company"); 
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   String Platform = rs.getString("platform"); 
   jTextArea5.append("Company:" 
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             return; 
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           // The username / password to connect u
           String username = "root"; 
           String password = "qwerty"; 
 
           // Make a connection with the database.
           Connection con; 
           try { 
             con = DriverManager.getConnection(ur
password); 
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               "Unable to make a connection to the
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           try { 
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      ResultSet rs = stmt.execute
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         String password = "qwerty"; 

           con = DriverManager.getConnection(url, username, 
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 { 

     Statement stmt = con.createStatement(); 
          

     // using executeQuery(): 
      ResultSet rs = stmt.executeQuery( 
          "Select * from arrive where 
acompany="+quotate(acompany)+"AND origin="+quotate(origin)+""); 
                     //SELECT * FROM depart WHERE company = "unimap" 
AND destination = 'kangar'; 
       
      // moving forward in the result set: 
      while (rs.next()) { 
                 String Company = rs.getString("acompany"); 
   String Regno = rs.getString("aregno"); 
   String Origin = rs.getString("origin"); 
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   String Platform = rs.getString("platform"); 
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           // This URL s
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           String url = "jdbc:mysql://localhost/bluetooth"; 
 
           // The username / password to connect under. 
           String username = "root"; 
  
 
           // Make a connection with the database. 
           Connection con; 
           try { 
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           } 
           catch (SQLException e) { 
             System.out.println( 
               "Unable to make a connection to the database.\n" +
               "The reason
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           try

         
 
  
 

  



             // Close the connection when finished 
             con.close(); 
 
           } 
           catch (SQLException e) { 
             System.out.println( 
               "An error occured\n" + 
               "The SQLException message is: " + e.getMessage()); 
             return; 
    } 
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    private javax.swing.JButton jButton6; 
    pri
    pri
    private javax.swing.JButton jButton9; 
    private javax.swing.J
    private javax.swing.J
    private javax.swing.JLabel jLabel11; 
    private javax.swing.JLabel jLabel12; 
    private javax.swing.JLabel jLabel13; 
    private javax.swing.JLabel jLabel14; 
    private javax.swing.JLabel jLabel15; 
    private javax.swing.JLabel jLabel16; 
    private javax.swing.JLabel jLabel17; 
    private javax.swing.JLabel jLabel18; 
    private javax.swing.JLabel jLabel19; 
    private javax.swing.JLabel jLabel2; 
    private javax.swing.JLabel jLabel20; 
    private javax.swing.JLabel jLabel21; 
    private javax.swing.JLabel jLabel22; 
    private javax.swing.JLabel jLabel23; 
    private javax.swing.JLabel jLabel24; 
    private javax.swing.JLabel jLabel25; 
    private javax.swing.JLabel jLabel26; 
    private javax.swing.JLabel jLabel27; 
    private javax.swing.JLabel jLabel28; 
    private javax.swing.JLabel jLabel29; 
    private javax.swing.JLabel jLabel3; 
    private javax.swing.JLabel jLabel30; 
    private javax.swing.JLabel jLabel31; 
    private javax.swing.JLabel jLabel32; 
    private javax.swing.JLabel jLabel33; 
    private javax.swing.JLabel jLabel34; 

utton jButton4; 
utton jButton5; 

vate javax.swing.JButton jButton7; 
vate javax.swing.JButton jButton8; 

Label jLabel1; 
Label jLabel10; 

  



    private javax.swing.JLabel jLabel35; 
 
    private javax.swing.JLabel jLabel4; 
   private javax.swing.JLabel jLabel36; 

    private javax.swing.JLabel jLabel5; 
    private javax.swing.JLabel jLabel6; 
    private javax.swing.JLabel jLabel7; 
   

   private javax.swing.JMenu jMenu1; 
    private javax.swing.JMenu jMenu2; 
    private javax.swing.JMenuBar jMenuBar1; 
    private javax.swing.JMenuItem jMenuItem1; 
    private javax.swing.JMenuItem jMenuItem2; 
    private javax.swing.JPanel jPanel1; 
    private javax.swing.JPanel jPanel10; 
    private javax.swing.JPanel jPanel11; 
    private javax.swing.JPanel jPanel12; 
    private javax.swing.JPanel jPanel13; 
    private javax.swing.JPanel jPanel14; 
    private javax.swing.JPanel jPanel15; 
    private javax.swing.JPanel jPanel16; 
    private javax.swing.JPanel jPanel17; 
    private javax.swing.JPanel jPanel2; 
    private javax.swing.JPanel jPanel3; 
    private javax.swing.JPanel jPanel4; 
    private javax.swing.JPanel jPanel5; 
   
   
    pr
    private javax.swing.JPanel jPanel9; 
    private javax.swing.JScrollPane jScrollPane1; 
    private javax.swing.JScrollPane jScrollPane2; 
    private javax.swing.JScrollPane jScrollPane3; 
   private javax.swing.JScrollPane jScrollPane4; 
   private javax.swing.JScrollPane jScrollPane5; 
   private javax.swing.JScrollPane jScrollPane6; 
  
   
    private javax.swing.JTabbedPane jTabbedPane1; 
    private javax.swing.JTabbedPane jTabbedPane2; 
    private javax.swing.JTabbedPane jTabbedPane3; 
    private javax.swing.JTable jTable1; 
   r
   u
   u
    public static javax.swing.JTextArea jTextArea3; 
    public static javax.swing.JTextArea jTextArea4; 
    public static javax.swing.JTextArea jTextArea5; 
    private javax.swing.JTextArea jTextArea6; 
    public static javax.swing.JTextField jTextField1; 
    private javax.swing.JTextField jTextField10; 
    private javax.swing.JTextField jTextField11; 
    private javax.swing.JTextField jTextField12; 
    public static javax.swing.JTextField jTextField13; 
    private javax.swing.JTextField jTextField14; 
    private javax.swing.JTextField jTextField15; 
    private javax.swing.JTextField jTextField16; 
    private javax.swing.JTextField jTextField17; 
    private javax.swing.JTextField jTextField18; 
    private javax.swing.JTextField jTextField19; 
    public static javax.swing.JTextField jTextField2; 

 private javax.swing.JLabel jLabel8; 
    private javax.swing.JLabel jLabel9; 
 

 private javax.swing.JPanel jPanel6; 
 private javax.swing.JPanel jPanel7; 

ivate javax.swing.JPanel jPanel8; 

 
 
 
  private javax.swing.JScrollPane jScrollPane7; 

 private javax.swing.JScrollPane jScrollPane8; 

 p ivate javax.swing.JTable jTable2; 
 p blic static javax.swing.JTextArea jTextArea1; 
 p blic static javax.swing.JTextArea jTextArea2; 

  



    private javax.swing.JTextField jTextField20; 
    private javax.swing.JTextField jTextField21; 
    private javax.swing.JTextField jTextField22; 
    private javax.swing.JTextField jTextField23; 
    private javax.swing.JTextField jTextField24; 
    private javax.swing.JTextField jTextField25; 
    private javax.swing.JTextField jTextField26; 
    private javax.swing.JTextField jTextField27; 
    private javax.swing.JTextField jTextField28; 
    private javax.swing.JTextField jTextField29; 
    private javax.swing.JTextField jTextField3; 
    private javax.swing.JTextField jTextField30; 
    private javax.swing.JTextField jTextField31; 
    private javax.swing.JTextField jTextField32; 
    public static javax.swing.JTextField jTextField33; 
    private javax.swing.JTextField jTextField34; 
    private javax.swing.JTextField jTextField4; 
    private javax.swing.JTextField jTextField5; 
    private javax.swing.JTextField jTextField6; 
    private javax.swing.JTextField jTextField7; 
    private javax.swing.JTextField jTextField8; 
    private javax.swing.JTextField jTextField9; 
    // End of variables declaration//GEN-END:variables 
   private ConnectionProtocol protocol; 
   private MyDBConnection mdbc; 
   private java.sql.Statement stmt; 
   private Connection connection; 
 

 
 
 
 
 
 
 
 
 
 

 
 

package ui; 

 
 
 
 
}
 
 
 
 
 
 
 
 

 

 
 

  



 
import javax.bluetooth.LocalDevice; 
imp t
import javax.microedition.io.StreamConnectionNotifier; 
 
public class ServerThread extends Thread { 
 
 private ConnectionProtocol protocol; 

public ServerThread(ConnectionProtocol protocol) { 
 this.protocol = protocol; 
} 

public void run() { 
 try { 
  LocalDevice device = LocalDevice.getLocalDevice(); 
 
device.setDiscoverable(BluetoothSettings.DISCOVERY_MODE); 

     + ";name=Bluetooth Bus Info"; 

 

   Log.log("Waiting for connection..."); 
  protocol.handleServerConnection(new 

())); 

 } catch (Exception e) { 
read-Exception", e); 

} 

 

 
 

 

 
 

or  javax.microedition.io.Connector; 

 
 
 
 
 
 
 
 
 
 
   String url = "btspp://localhost:" + 
BluetoothSettings.UUID 

 
   Log.log("Create server by uri: " + url); 
   StreamConnectionNotifier notifier = 
(StreamConnectionNotifier) Connector 
     .open(url); 

   while (true) { // infinite loop to accept 
connections. 
 
  
WorkaroundStreamConnection(notifier.acceptAndOpen

  }  
 
   Log.log("ServerTh
  } 
 } 
 

 
 

 
 
 

 
 

 

  



 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

APPENDIX II 
 

STEP TO DEVELOP JAVA APPLICATION IN 

NETBEANS 5.5  

 
 
 
 
 
 
 
 

 
 

 

 

 

 

 
 
 
 

  



Create Java General Application in NetBeans IDE 5.5 
 

1. Start NetBeans IDE.  

 

2. In the IDE, choose File > New Project, as shown in the figure below. 

 
 

 
 
 

3. In the New Project wizard, expand the General category and select Java 

Application as shown in the figure below. Then click Next.  

 

 
 
 

  



 
4. In the Name and Location page of the wizard, do the following (as shown 

in the figure below):  

• In the Project Name field, type Hello World App. 

• In the Create Main Class field, type helloworldapp.HelloWorldApp. 

• Leave the Set as Main Project checkbox selected. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  



5. 

ing 

• The Projects window, which contains a tree view of the components of the 

ource files, libraries that your code depends on, and so on.  

urce Editor window with a file called HelloWorldApp open.  

between 

Click Finish. 

The project is created and opened in the IDE. You should see the follow

components:  

project, including s

• The So

• The Navigator window, which you can use to quickly navigate 

elements within the selected class. 

 
 
 
 
 
 
 
 
 

  



6. Adding Code to the Generated Source File 

Because you have left the Create Main Class checkbox selected in the New Project 

wizard, the IDE has created a skeleton class for you. You can add the "Hello World!" 

message to the skeleton code by replacing the line:  

            // TODO code application logic here 
     
with the line:  
            System.out.println("Hello World!"); 
     

Save the change by choosing File > Save. 

The file should look something like the following: 

 /* 
 * HelloWorldApp.java 
 * 

Cre PM 

 * To change this template, choose Tools > Template Manager 

 /** 

pp() { 

 

 void main(String[] args) { 
         //Display "Hello World!" 
         System.out.println("Hello World!"); 
     } 

} 
     

 

 * ated on September 15, 2006, 5:27 
 * 

 * and open the template in the editor. 
 */ 
 
 package helloworldapp; 
 

 * The HelloWorldApp class implements an application that 
 * simply displays "Hello World!" to the standard output. 
 */ 
 public class HelloWorldApp { 
 
     /** Creates a new instance of HelloWorldApp */ 
     public HelloWorldA
     } 

     /** 
     * @param args the command line arguments 
     */ 
     public static

 
 

 
 
 
 

 
 
 

  



7. Compiling the Source File 

To compile your source file, choose Build > Build Main Project from the IDE's main 

menu.  

The Output window opens and displays output similar to what you see in the 

following figure. 

 

If the build output concludes with the statement BUILD SUCCESSFUL, You have 

successfully compiled your program. 

If the build output concludes with the statement BUILD FAILED, you probably have a 

ntax error in your code. Errors are reported in the Output window as hyper-linked 

t. Yo er-link to navigate to the source of an error. You can 

then fix the error and once again choose Build > Build Main Project. 

When you build the project, the byte code file HelloWorldApp.class is generated. 

You can see where the new file is generated by opening the Files window and 

expanding the Hello World App/build/classes/helloworldapp node as shown in 

the following figure. 

sy

tex u double-click such a hyp

  



 
 

Now that you have built the project, you can run your program.  

. Running the Program 

rom the IDE's menu bar, choose Run > Run Main Project. 

he next figure shows what you should now see. 

8

F

T

 
 
 
 
 
 
 
 
 
 
 
 
 
 

  



 
 
 

 
 

 
 

 

APPENDIX III 
 

MAKING A SIMPLE MYSQL CLIENT IN NETBEANS 

 
 
 

 

 

 
 

 
 
 
 

 

 
 
 
 

 

 

 
 
 

 
 
 
 

  



1. Connecting to MySQL database 

I expect that the readers already have a suitable environment of MySQL database 

server working, having a database with an enough grant to a given user. In this 

sample, 

database name: nonidb 

ser: noniko 

password: (blank) <- because it's a merely a sample at all. If you have some 

portant data, please set a proper password! 

, y ared mysql-connector-

u

im

Also ou would get a JDBC driver file for MySQL. I prep

java-3.1.6-bin.jar file through MySQL developer's web site. 

Now, let's go to NetBeans. Click the "Runtime" tab to switch the window you may 

usually see "Projects" or "Files" window. 

 

r. Right-click the "Drivers" node to show 

context menu and select "Add Driver".  

 

 

 

2. Select "Add Driver" in Runtime Window 

You will find "Databases" node here. open this node to get "Drivers" node under it. If 

you open more to show the content of "Drivers", you will find only "JDBC-ODBC". 

The first thing to do is add MySQL drive

  



Then the setting window appears. 

 

3. Find the location of JDBC driver file. 

By clicking "Add" button you can search the driver file graphically. As the case 

above, I prepared D:\nonidata\nb4worksnew folder for contain project folders and lib 

subfolder to contain library files. 

If you select the driver file's location, Driver Class and Name are set automatically. In 

the case of MySql JDBC driver, the old class name is set first. But click "Find" 

button, then the progress bar below became active and finally "Searching for driver 

n. 

r Class" setting. You can select the current class name 

classes finished" is show

Then open the combo of "Drive

of the JDBC Driver. 

 

 

 

  



3. Change class name to that of current version. 

 "  added under "Driver" node. Right-click it to Click OK", then the new driver node is

select "Connect Using.." from context menu. 

 

4. Select "Connect Using..." from context menu 

The setting window appears. Here Database URL, User Name and Password are 

needed ( In this case Password is blank).Click OK then you could see "Connection 

established" message in the progress bar below. The page might be switched to 

"Advanced", but in this case there is no advanced setting needed. 

 

After the connection established, a node fo this connection is appeared. Let's proceed 

 

r 

to next step . 

 

 

 

 

  



5. Creating a sam

Right-Click the node for the connection established above, Select "Create Table...". 

ple table 

 

6. Select "Create Table" from context menu 

Then a window appears for setting the table to create. To display the required setting 

ey, this window might have to be expanded manually. The important settings are K

Column name, Data type and Size, depending on the Data type. 

 

 

 

 

 

 

 

 

 

 

  



7. Creating a table in NetBeans 

In this case I made a sample table "cars" aving carid, name, vendor and type as 

fields. the field carid is the primary key. A  the fields have data type of VARCHAR. 

Only carid has 10 for size and all others have 20. 

Once the table created, you can see its node under the connection node. The structure 

of the table "cars" are displayed. 

 h

ll

 
 

8. Insert the first data  

Now let's insert the first row by sending SQL command. Right-Click any node under 

the connection node to display "Execute Commands..."menu item 

 
 

e same place of source 

editor. Too large, so I will not show the screenshot of the whole appearance. The 

Then the large window of operating command appears at th

important spots are, first of all, the text area for inputting command. 

 
 

  



9. Input a whole command sentence. 

Click "Execute" button and, if the command is valid, you can see the "Command 

successfully excuted" message below. More to make sure, right-click the "cars" node 

and select "View data". 

 
 

Right-Click the "cars" node to view data. 
 

 

10. First data inserted 

Yeah! The first data were successfully erted. But you might think the whole 

sentence "insert into..." bothering. I did. So I made up mind to build an application to 

insert data by more graphical operation. 

11. Creating a new Java Project 

Let's create a new Java Project for the application. Select from Menu bar "File"-

"New Project". In the new project wizard, select "General"->"Java Application" as 

the project type. In my case the project name was "mysqloperation" and the location 

 "create main project". 

 

 

 

ins

>

was "d:\nonidata\nb4worksnew\mysqloperation". Check off

After creating the project, create new package. In my case, "mysqlop". 

  



12. Creating a utility class for connecting database 

Operation of database in Java is very complicated, requiring connection, statement, 

resultset and many try&catch. So I used a utility class dealing with such operation. 

The whole code is shown here, MyDBConnection.java.

init() method is for connecting MySQL database. 

getConnection() method is to be called after init()method, to give to the other class 

the established connection. 

close() 

ey have been 

To use this file, classpath to the JDBC driver must be set for this project. Right-click 

the "mysqloperation" project and select "Properties..." from the context menu. In the 

indow, select "Build"->"Compiling Sources".Click "Add 

 setting , so you can 

two methods and destroy() methods are for settling the end of operation. 

Closing connection, statement or resultset requires try&catch so th

extracted here. 

"Project Properties" w

JAR/Folder..." button near the "Classpath for Compiling Source"

search the location of the JDBC jar file. 

 

Adding JDBC jar file to classpath 

 

 

 

 

  



13. Creating the Table Model 

Then I prepared a cusomized Table Model for the JTable to use in this app. 

The whole code is shown here, CarTableModel.java. 

To write this code I used some nice tools of NetBeans.  

First, create a new Java Class file named CarTableModel.java. It has a very plain and 

empty template, just with package and class declaration.  

 

Edit manually the class declaration to extend "AbstractTableModel" class. The editor 

soon show the red and waved underline to show errors. One cause of this is lack of 

importing "javax.swing.ta is error is fixed by right-

clicking somewhere of the code and select "Fix Imports". 

ble.AbstractTableModel" class. Th

 

import javax.swing.table.AbstractTableModel; 

has been inserted near the top of the source code. 

But still the red underline remains. The remaining cause of this is lack of 

implementation of proper abstract methods. 

This is fixed by "overriding method" tool invoked this way... 

Use "Fix imports" tool 

You can check the declaration 

  



 
 

13. Use "Overrice Methods" tool 

The required implementations are extracted checking "Show Abstract Methods Only".  

 
 
 
 

 
 

 
 
 
 
 

 
 

 
 

 
 

 

 
 

  



14. Required implementations are listed 

Select all of the three methods by clicking the node and "OK". 

 

Required implementations are inserted automatically 

(int param) method, otherwise we 

 of the table. 

 contents. 

The code is specified to access the specific table "cars", so the number of column is 

fixed to 4.  

Each column's name is also known and can be set directly. 

This time I used Generics, a new feature of JDK5.0, for the first time. It worked 

successfully in NB (Clap hands!) 

 

Now the red line is gone!  

In fact, we also need to override getColumnName

couldn't get customized headders

Let's fill the

  



15. Creating the JFrame Form class-the Form design 

Now let's create the JFrame Form Application, The main class of this project! 

"JFrame Form" can be selected in the new wizard. The name is "InsertTable" in my 

able.java". 

 

ck()" to "Generate Resize Code". 

case, which created a source file "InsertT

First, design the form. It should be take a vertically long window, so I fixed the form

size instead of use "packing". 

Select "JFrame" node in the Inspector window to show its properties. Change "Form 

Size Policy" from default "Generate pa

 

16. To fix the Form size. 

Then "Form Size" property becomes editable. Edit it as: 

 
 
 
 
 
 
 

 

 
 
 
 

 

 

  



17. The Form size edited. 

This form will be separated vertically into three parts: 

(1)JTextfields or JComboBox to input the new data. 

(2)JButton to send data and show message. 

(3)The JTable. 

The first two should be located on eachJPanel, and the JTable on a JScrollPane. This 

is the basic parts. 

 
 

18. JPanels and JScrollPane to locate the components. 

ean, 

 are located to North, Center and South of 

On dataPanel, 3JTextFields and one JComboBox to input data and 4JLabels for 

The default layout onJPanel is FlowLayout in NetBeans. It must be changed: 

Notice the vertical positions of the nodes don't mean their actual locations. I m

dataPanel, sendPanel and tablePane

BorderLayout, respectively. 

explanations should be located. I decided GridLayout is the best to set these locations. 

  



 
 

ies of this Grid Layout are displayed. Set column number to 2, row 

19. Change to GridLayout 

Then propert

number to 4. 

 
 

d by drag and drop on the form, if Then locate the components. They could be move

you are not satisfied with the location. 

 

 
 
 
 
 
 

 
 
 

 

 

  



20. Moving the JComboBox within the GridLayout. 

The component might escape to a very wrong position, as a different panel. Don't 

worry; you can move its location by drag and drop within the Inspector window, too. 

 
 

21. Moving the JComboBox within the Inspector window. 

After all components are set, customize their name to show their roles. 

Also customize text property of each JLabe  each JTextField. Here 

is an example of editing "text" property of JLabel: 

l, and eraze that of

 
 

22. Customizing "text" property to s  "ID:"as JLabel 

Then sendPanel to locate JButton and and or this 

JPanel, with 1 column and two rows. The name and "text" property are customized. 

how

JLabel. Also GridLayout is set f

 
 
 

  



23.       In this way the components, other than JTable, arearranged as below: 
 

 

Components without JTable have been customized. 

24. Customizing JTable 

As shown above, at this point the JTable has 4x4 structure and empty data. Let's 

customize it to show the content of the table "cars" of MySQL database. 

Select the JTable now is named "carTable" in the Inspector window to show its 

odel" property and click the "..." button at the right edge. properties. Find the "m

 

carTable and its "model" property 

 

 

  



Then the editor window appears. The default 4x4 structure is set in this window. Let's 

". change "Select Mode" from "TableModelEditor" to "FormConnection

 
 

25. Switching from default Table Model Editor to Form Connection mode. 

In the Form Connection mode, click the radio of "User Code" in the option window.  

 
 

26. Form Connection mode 

Then look at the bottom of this window. The "Advanced" button is there. Click it! 

 

"Advanced" button at the bottom of the window 

A window appears to edit before and after the code of setting the TableModel for the 

heck both to edit. JTable. This time c

  



 
 

The method named getResultFromCars should be created in the source code of 

blic ltFromCars() { 

    
QLException e){} 

"InsertTable.java" manually like 
 
pu  ResultSet getResu
 
        ResultSet rs=null; 
 
        try{ 
            rs=stmt.executeQuery("Select * from cars"); 
 
  
  

  } 
      catch(S

 
        return rs; 
 
    } 
Click OK to return the "User Code" to fill. 
 

 
Note that here semicolon";" to terminate the sentence SHOUD NOT BE input. 
Why? check the source code. Check the itComponents() method. Here! 
 

In

 
Light-blue "Protected""Uneditable" area? Who said so? Ho-ho-ho! You can edit 
frrreely by this means prepared by NetBeans! 
 
 

  



26. First running of InsertTable 

To make a first test run of this customized JTable, we still have something to do. 
First, declaration. 

private MyDBConnection mdbc; 
private java.sql.Statement stmt; 

They are to be written somewhere in the source. Near the EOF, close to other 
variables, would be nice. 

Then the constructor. Note that we should add throw declaration to it 

 

to avoid that annoying compile error "java.sql.SQLException is not reported...". 

The whole content of the constructor is : 

public InsertTable() throws  Exception{ 
 
         mdbc=new MyDBConnection(); 
         mdbc.init(); 
         Connection conn=mdbc.getMyConnection(); 
         stmt= conn.createStatement(); 
 
        initComponents(); 
    } 

void the same compile error. Edit the main method prepared by One more to a
NetBeans: 

 

Add try-catch to the main method  

lect main class might be appear. In the list 
his "InsertTable.class". Select it. 

Now let's run the project! An window to se
you will find only t

  



 

The tabledata of MySQL was shown 

The only one row existing in "cars" table of MySQL database has been displayed! 

27. Taking a little care... 

Now that we could disp
ke a little care for bette

lay existing data from MySQL to JTable, Let's feel settled and 
r application. 

> 
ged automatically to 
cted. 

ta

One thing is a proper termination of this application, All the sessions with 
MySQL(connection, statement, resultsets) must be closed. 
This application is terminated by closing the window. So we should add an event 

rocess g metp in hod for WindowClosing event.  
Select "JFrame" in the Inspector window to show its properties window, and then 
click "events" to switch the page. Find "windowClosing" event. It is set to be <none
by default, but when you click the word <none>, it would be chan

ile this row is sele"formWindowClosing"...press the Enter key wh

 

  



Setting windowClosing event of JFrame  

Then the source code appears to enable to edit the method. 

 
 

Edit "formWindowClosing" method 

Close the statement and the connection. 

The other thing is to set items of the JComboBox named typeCombo. Yes, it should 
be equipped to select drive type of a car. 

Select "typeCombo" node in the Inspector Window to show its properties. Find 
"model" property and click "..." button on the right edge, just like we did for setting 
the TableModel for JTable. 
A window appears, This time we use the default ComboBoxModelEditor. 

 
 

Input a new item in "Item:" field and click "Add" button. That's easy! I prepared the 
items "FF", "FR", "MR" and"4WD" as drive type. Are there anything else? 

28. Inserting data to MySQL 

The finishing spurt! Inserting data to MySQL should be done at the clicking "Send" 
button(the JButton named "sendButton"). 

  



In NetBeans' GUI Editor, it's very easy to make event processing method for JButton. 

ted in the source file. Let's fill 

); 

pe) 

; 

etText("1 row inserted"); 

tContentPane().removeAll(); 
Components(); 

or occurred in inserting data"); 

 and after removing 
able's appearance...If I were 

his is, as is 
 

e for InsertTable.java

Just double-click the JButton itself on the form. 

The "sendButtonActionPerformed" method is crea
e content as this: th

private void sendButtonActionPerformed(java.awt.event.ActionEvent 
evt) {//GEN-FIRST:event_sendButtonActionPerformed 
        // TODO add your handling code here: 
 
        String carid=idField.getText(); 
        String name=nameField.getText(); 

orField.getText();         String vendor=vend
        String type=(String)typeCombo.getSelectedItem(
 
        String insertStr=""; 
 
        try{ 
 

or, ty            insertStr="insert into cars (carid, name, vend
values(" 
                    +quotate(carid)+"," 
                    +quotate(name)+"," 
                    +quotate(vendor)+"," 
                    +quotate(type) 
                    +")"; 
 
            int done=stmt.executeUpdate(insertStr)
 

Label.s            comment
 
          ge  

            init
 
        } 
        catch(Exception e){ 

mentLabel.setText("Err            com
            e.printStackTrace(); 
        } 
 
    }//GEN-LAST:event_sendButtonActionPerformed 

Note that initComponents method is called afte
the current comtent pane.It's necessary to refresh the JT

r inserting data,

skilled more, I could refresh only JTable, instead of the whole container. T
called in Japanese a way like "Chopping tofu with the axe". Sorry!

Also note here the quotate method is called. I created it not to hit so many quotation 
marks: 

public String quotate(String content){ 
     
        return "'"+content+"'"; 
    } 

Now the whole cod .  

  



Run the project! Input data and click the "Send" button. Now you can see another ro
st ins

w 
serting a few more! ju erted in the JTable. Repeat in

 
 

Operating the completed application 

...And let's make sure these data will be viewed also from NetBeans' utility. 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

  



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

APPENDIX IV 
 
OURCE CODE 

 
 
 

 

PHONE SIDE S
 
 
 

 
 
 
 
 
 
 
 

package ui; 

  



 
import javax.bluetooth.BluetoothStateException; 
port javax.bluetooth.LocalDevice; 

port eChangeException; 

blic class BluetoothBusInfo extends MIDlet { 

protected void startApp() throws MIDletStateChangeException { 
 

 try { 

calDevice().getFriendlyNa

setUserName("user"); 

w ServerThread(protocol).start(); 
 new DiscoveryThread(protocol).start(); 

 ui.setCurrent(); 

} 

void destroyApp(boolean arg0) throws 

r();

 

im
import javax.microedition.midlet.MIDlet; 
im  javax.microedition.midlet.MIDletStat
 
pu
 
 
  LcduiUI ui = new LcduiUI(this);
  ConnectionProtocol protocol = new ConnectionProtocol(ui); 
 
 
  
 protocol.setUserName(LocalDevice.getLo
me()); 
  } catch (BluetoothStateException e) { 
   protocol.
  } 
 
  ne
 
 
 
 } 
 
 protected void pauseApp() { 
 
 
 protected 
MIDletStateChangeException { 
  Log.clea  
 } 
 
} 
 
 

 
 
 
 

 
 
 
 
 
 
 
 
 
 

  



/* 
 * BluetoothSettings.java 
 * 
 * Created on April 11, 2007, 4:00 PM 
 * 
 * To change this template, choose Tools | Template Manager 
 * and open the template in the editor. 
 */ 
 
package ui; 
 
import javax.bluetooth.DiscoveryAgent; 
import javax.bluetooth.ServiceRecord; 
import javax.bluetooth.UUID; 
 
public interface BluetoothSettings { 
 
 /** 
  * A constant UUID for Serial Port Profile. 

new UUID("1101", true); 

ode. In global mode no paring is 

int DISCOVERY_MODE = DiscoveryAgent.GIAC; 

bluetooth.ServiceRecord#getConnectionURL(int 
ty, 

c static final int SECURITY_OPTIONS = 

onnectionURL(int 
quiredSecurity, 

STER = false; 

 * A workaround for a bug in bluecove. BlueCove may crash if 

  

public static final boolean WORKAROUND_BLUECOVE = true; 

 remote device. 

  */ 
 static public final UUID UUID = 
 
 /** 
  * A constant discovery m
needed. 
  */ 
 static public final 
 
 /** 
  * @see javax.
requiredSecuri

 *      boolean mustBeMaster)  
  */ 
 publi
ServiceRecord.NOAUTHENTICATE_NOENCRYPT; 
 
 /** 

vax.bluetooth.ServiceRecord#getC  * @see ja
re
  *      boolean mustBeMaster) 
  */ 
 public static final boolean MUST_BE_MA
 
 /** 
 
getFriendlyName 
  * method is used. 
  *
  * @see javax.bluetooth.RemoteDevice#getFriendlyName(boolean 
alwaysAsk) 
  */ 
 
 
 /** 
  * A constant number to search services from
Services are 
  * searched couple of times from a device if service search 
returned with 
  * search error. 
  *  

  



  * @see 
javax.bluetooth.DiscoveryListener#serviceSearchCompleted(int 
  *      transID, int respCode) 

DiscoveryListener#SERVICE_SEA  * @see javax.bluetooth. RCH_ERROR 

c static final int MAX_TRY_COUNT_TO_SEARCH_SERVICE = 2; 

s how many seconds are slept 

IME_BEFORE_NEW_DISCOVERY = 20; 

 

 

 
 
 
 

  */ 
 publi
 
 /** 
  * A constant number which tell
between 
  * discoveries in discovery thread. 
  */ 
 public static final int SLEEP_T
 
} 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 
 
 

  



package ui; 
 
import java.io.DataInputStream; 
import java.io.DataOutputStream; 
import java.io.IOException; 
import java.util.Enumeration; 

luetooth.BluetoothStateException; 
port javax.bluetooth.LocalDevice; 
ort javax.microedition.io.Connection; 
port javax.microedition.io.StreamConnection; 

/** 
 * A class that handles connections to remote chatters and the 
protocol used in 
 * messaging. 
 *  
 */ 
public class ConnectionProtocol { 
 
 /** 
  * An interface for UI event handler. 
  */ 
 static public interface EventHandler { 
  public void chatMessage(String userName, String msg); 
 
  public void chatLeave(String userName); 
 
  public void chatEnter(String userName); 

 Connection conn; 

ataOutputStream out; 

am in; 

onnection conn, 

m out, String uName) { 
ss; 

 
ead which 

loop starts the remote 

import java.util.Hashtable; 
 
import javax.b
im
imp
im
 

 
  public void setProtocol(ConnectionProtocol protocol); 
 } 
 
 class RemoteChatter { 
 
 
  D
 
  DataInputStre
 
  String userName; 
 
  String btAddress; 
 
  RemoteChatter(String btAddress, C
DataInputStream in, 
    DataOutputStrea
   this.btAddress = btAddre
   this.conn = conn; 
   this.in = in; 
   this.out = out; 
   this.userName = uName; 
  } 
 
  /**
   * A method that starts the message reading thr
contains the 
   * main chat loop. When the main 
chatter enters 

  



   * in chat. Messages are read from the connection while 

hatter leaves from the chat. 

  new Thread() { 
    public void run() { 
     ui.chatEnter(userName); 
     while (true) { // infinite loop to read 
messages. 
      try { 
       ui.chatMessage(userName, 
readString(in)); 
      } catch (IOException e) { 
       ui.chatLeave(userName); 
       close(); 
       break; 
      } 
     } 
    } 
   }.start(); 
  } 
 
  void close() { 
   synchronized (btAddress2remoteChatters) { 
    Log.log("Close chat connection."); 
    try { 
     conn.close(); 
    } catch (IOException e) { 
    } 
    btAddress2remoteChatters.remove(btAddress); 
   } 
  } 
 } 
 
 protected Hashtable btAddress2remoteChatters = new Hashtable(); 
 
 protected EventHandler ui; 
 
 protected String userName; 
 
 public ConnectionProtocol(EventHandler ui) { 
  this.ui = ui; 
  ui.setProtocol(this); 
 } 
 
 public void handleServerConnection(final StreamConnection 
connection) { 
  // A server connections shall be handled immediately. 
Hence, a new 
  // thread is started to do the actual protocol handling. 
  new Thread() { 
   public void run() { 
    DataInputStream in; 
    try { // to read client's bluetooth address 
     in = connection.openDataInputStream(); 
     Log.log("Read bt address."); 
     String btAddress = readString(in); 
     Log.log("bt addres is: " + btAddress); 
     handleConnection(connection, btAddress, 
in, connection 

it's open. When 
   * the connection closes c
   */ 
  void startMessageReadingThread() { 
 

  



       .openDataOutputStream()); 
    } catch (Exception e) { 
    
 Log.log("ConnectionProtocol.handleServerConnection-
Exception",e); 
    } 
   } 
  }.start(); 
 } 
 
 public void handleClientConnection(StreamConnection connection, 
   String btAddress) { 
  DataOutputStream out; 
  try { // to write my bluetooth address to server 
   out = connection.openDataOutputStream(); 
   Log.log("Write bt address."); 
   writeString(out, 
LocalDevice.getLocalDevice().getBluetoothAddress()); 
 
   handleConnection(connection, btAddress, connection 
     .openDataInputStream(), out); 
  } catch (Exception e) { 
   Log.log("ConnectionProtocol.handleClientConnection-
Exception", e); 
   try { 
    connection.close(); 
   } catch (IOException e1) { 
   } 
  } 
 } 
 
 protected void handleConnection(StreamConnection connection, 
   String btAddress, DataInputStream in, 
DataOutputStream out) 
   throws Exception { 
 
  btAddress = btAddress.toLowerCase(); 
 
  // The synchronization is very important here. Otherwise 
there might be 
  // two connection between devices A and B if both create 
a connection to 
  // each other at the same time. 
  synchronized (btAddress2remoteChatters) { 
   if 
(!btAddress2remoteChatters.containsKey(btAddress)) { 
    Log.log("Write user name."); 
    writeString(out, userName); 
    Log.log("Read user name."); 
    String userName = readString(in); 
    Log.log("userName: " + userName); 
    RemoteChatter chatConn = new 
RemoteChatter(btAddress, 
      connection, in, out, userName); 
    btAddress2remoteChatters.put(btAddress, 
chatConn); 
    Log.log("Start message read thread"); 
    chatConn.startMessageReadingThread(); 
   } else { 
    connection.close(); 
   } 

  



  } 
 } 
 
 /** 
  * @return true if connection is made already or the address is 
local 
  *         Bluetooth address. 
  */ 
 public boolean hasConnection(String bluetoothAddress) { 
  try { 
   return 
btAddress2remoteChatters.containsKey(bluetoothAddress 
     .toLowerCase()) 
     || 
bluetoothAddress.equalsIgnoreCase(LocalDevice 
      
 .getLocalDevice().getBluetoothAddress()); 
  } catch (BluetoothStateException e) { 
   Log.log("ConnectionProtocol.hasConnection()", e); 
   return true; 
  } 
 } 
 
 public void setUserName(String userName) { 
  this.userName = userName; 
  ui.chatEnter(userName); 
 } 
 
 /** 
  * Broadcasts given message to other chatters and then sends 
the message to 
  * user's own chat UI. 
  */ 
 public void broadcastMessage(String msg) { 
  Log.log("Broadcast message: " + msg); 
  for (Enumeration e = btAddress2remoteChatters.elements(); 
e 
    .hasMoreElements();) { 
   RemoteChatter chat = (RemoteChatter) 
e.nextElement(); 
   try { 
    writeString(chat.out, msg); 
   } catch (IOException e1) { 
    chat.close(); 
   } 
  } 
 
  ui.chatMessage(userName, msg); 
 } 
 
 /*- 
  *  
  *  ----  Util methods ---- 
  */ 
 
 protected void writeString(DataOutputStream out, String str) 
   throws IOException { 
  out.writeUTF(str); 
  out.flush(); 
 } 
 

  



 protected String readString(DataInputStream in) throws 
IOException { 
  return in.readUTF(); 
 } 
 
} 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  



/* 
 * DiscoveryThread.java 
 * 
 * Created on April 11, 2007, 3:58 PM 
 * 
 * To change this template, choose Tools | Template Manager 
 * and open the template in the editor. 
 */ 
 
package ui; 
 
import java.io.IOException; 
import java.util.Vector; 
 
import javax.bluetooth.DeviceClass; 
import javax.bluetooth.DiscoveryAgent; 
import javax.bluetooth.DiscoveryListener; 
import javax.bluetooth.LocalDevice; 
import javax.bluetooth.RemoteDevice; 
import javax.bluetooth.ServiceRecord; 
import javax.bluetooth.UUID; 
import javax.microedition.io.Connector; 
import javax.microedition.io.StreamConnection; 
 
/** 
 * A class that discovers new connections to other Bluetooth 
ChatApplications in 
 * remote devices. 
 */ 
public class DiscoveryThread extends Thread implements 
DiscoveryListener { 
 
 private Object waitMutex = new Object(); 
 
 private ConnectionProtocol protocol; 
 
 private Vector foundDevices = new Vector(); 
 
 private RemoteDevice currentDevice; 
 
 private boolean serviceSearchInError; 
 
 public DiscoveryThread(ConnectionProtocol protocol) { 
  this.protocol = protocol; 
 } 
 
 public void run() { 
  try { 
   while (true) { // infinite loop to discover new 
connections. 
 
    foundDevices.removeAllElements(); 
 
    DiscoveryAgent agent = 
LocalDevice.getLocalDevice() 
      .getDiscoveryAgent(); 
 
    // This thread starts an inquiry method and 
then waits for 
    // a notification from mutex. A Bluetooth 
thread will invoke 

  



    // the inquiryCompleted method and sends a 
notification to 
    // mutex. 
    // 
    // @see http://en.wikipedia.org/wiki/Mutex 
    synchronized (waitMutex) { 
     Log.log("Start inquiry method to found 
devices."); 
    
 agent.startInquiry(BluetoothSettings.DISCOVERY_MODE, this); 
     waitMutex.wait(); 
    } 
 
    UUID uuids[] = new UUID[] { 
BluetoothSettings.UUID }; 
    for (int i = 0; i < foundDevices.size(); i++) 
{ 
     serviceSearchInError = false; 
     for (int t = 0; t < 
BluetoothSettings.MAX_TRY_COUNT_TO_SEARCH_SERVICE; t++) { 
 
      // This thread starts a service 
search method and then 
      // waits for a notification from 
mutex. A Bluetooth 
      // thread will invoke the 
serviceSearchCompleted method 
      // and sends a notification to 
mutex. 
      synchronized (waitMutex) { 
       currentDevice = 
(RemoteDevice) foundDevices 
         .elementAt(i); 
       Log 
         .log("Start to 
search the Serial Port Profile(SPP) service from " 
           + 
deviceString(currentDevice)); 
       agent.searchServices(null, 
uuids, currentDevice, 
         this); 
       waitMutex.wait(); 
      } 
      if (!serviceSearchInError) 
       break; 
      else 
       // sleep few seconds before 
next service search. 
       Thread.sleep(2 * 1000); 
     } 
    } 
    Thread 
     
 .sleep(BluetoothSettings.SLEEP_TIME_BEFORE_NEW_DISCOVERY * 
1000); 
   } 
  } catch (Exception e) { 
   Log.log("DiscoveryThread-Exception", e); 
  } 
 } 
 

  



 /*- 
  *  
  *  --- Implement DiscoveryListener --- 
  *  
  * @see javax.bluetooth.DiscoveryListener 
  */ 
 
 public void inquiryCompleted(int arg0) { 
  synchronized (waitMutex) { 
   waitMutex.notify(); 
  } 
 } 
 
 public void deviceDiscovered(RemoteDevice dev, DeviceClass 
clazz) { 
  Log.log("Device found: " + deviceString(dev)); 
  if (!protocol.hasConnection(dev.getBluetoothAddress())) 
   foundDevices.addElement(dev); 
 } 
 
 public void servicesDiscovered(int transId, ServiceRecord[] 
records) { 
  Log.log("Service discovered."); 
  for (int i = 0; i < records.length; i++) { 
 
   if (records[i] == null) 
    continue; 
 
   String url = records[i].getConnectionURL( 
     BluetoothSettings.SECURITY_OPTIONS, 
     BluetoothSettings.MUST_BE_MASTER); 
   Log.log("Connecting to url: "+url); 
   try { 
    StreamConnection stream = (StreamConnection) 
Connector 
      .open(url); 
    stream = new 
WorkaroundStreamConnection(stream); 
    protocol.handleClientConnection(stream, 
currentDevice 
      .getBluetoothAddress()); 
    break; 
   } catch (IOException e) { 
    Log.log("DiscoveryThread-Exception", e); 
   } 
  } 
 } 
 
 public void serviceSearchCompleted(int transId, int respCode) { 
  serviceSearchInError = false; 
  String msg = null; 
  switch (respCode) { 
  case SERVICE_SEARCH_COMPLETED: 
   msg = "the service search completed normally"; 
   break; 
  case SERVICE_SEARCH_TERMINATED: 
   msg = "the service search request was cancelled by 
a call to DiscoveryAgent.cancelServiceSearch()"; 
   break; 
  case SERVICE_SEARCH_ERROR: 

  



   msg = "an error occurred while processing the 
request"; 
   serviceSearchInError = true; 
   break; 
  case SERVICE_SEARCH_NO_RECORDS: 
   msg = "no records were found during the service 
search"; 
   break; 
  case SERVICE_SEARCH_DEVICE_NOT_REACHABLE: 
   msg = "the device specified in the search request 
could not be reached or the local device could not establish a 
connection to the remote device"; 
   break; 
  } 
  Log.log("Service search completed - " + msg); 
 
  synchronized (waitMutex) { 
   waitMutex.notify(); 
  } 
 } 
 
 /*- 
  *  
  * --- Utility method --- 
  */ 
 
 private String deviceString(RemoteDevice dev) { 
  String ret = null; 
  try { 
   if (BluetoothSettings.WORKAROUND_BLUECOVE) 
    ret = ""; 
   else 
    ret = dev.getFriendlyName(false); 
  } catch (IOException e) { 
   ret = "none"; 
  } 
  ret += " - " + dev.getBluetoothAddress(); 
  return ret; 
 } 
 
} 
 
 

 
 
 
 
 
 
 
 
 
 
 

  



/* 
 * LcduiUI.java 
 * 
 * Created on April 11, 2007, 4:39 PM 
 */ 
 
package ui; 
 
import java.util.Date; 
import java.util.Vector; 
 
import javax.microedition.lcdui.Command; 
import javax.microedition.lcdui.CommandListener; 
import javax.microedition.lcdui.CustomItem; 
import javax.microedition.lcdui.Display; 
import javax.microedition.lcdui.Displayable; 
import javax.microedition.lcdui.Font; 
import javax.microedition.lcdui.Form; 
import javax.microedition.lcdui.Graphics; 
import javax.microedition.lcdui.TextField; 
import javax.microedition.midlet.MIDlet; 
 
public class LcduiUI extends Form implements CommandListener, 
  ConnectionProtocol.EventHandler { 
 
 /** 
  * A custom item that draws last messages to screen. 
  */ 
 class MessageArea extends CustomItem { 
  private int negHeight; 
 
  protected MessageArea(String label, int negHeight) { 
   super(label); 
   if (negHeight > LcduiUI.this.getHeight()) 
    this.negHeight = LcduiUI.this.getHeight() / 
4; 
   else 
    this.negHeight = negHeight; 
  } 
 
  protected int getMinContentWidth() { 
   return LcduiUI.this.getWidth(); 
  } 
 
  protected int getMinContentHeight() { 
   return LcduiUI.this.getHeight() - negHeight; 
  } 
 
  protected int getPrefContentWidth(int arg0) { 
   return getMinContentWidth(); 
  } 
 
  protected int getPrefContentHeight(int arg0) { 
   return getMinContentHeight(); 
  } 
 
  protected void paint(Graphics g, int w, int h) { 
 
   g.setColor(0xFFFFA0); // yellow-white 
   g.fillRect(0, 0, w, h); 
 

  



   Font f = Font.getDefaultFont(); 
   g.setColor(0); // black 
   g.setFont(f); 
 
   // paint last messages in screen. 
   synchronized (messages) { 
    int rowsLeft = getMinimumHeight() / 
f.getHeight(); 
    if ((getMinimumHeight() % f.getHeight()) > 0) 
     rowsLeft--; 
    for (int msgIdx = messages.size() - 1; 
rowsLeft >= 0 
      && msgIdx >= 0; msgIdx--) { 
     rowsLeft -= drawMessage(g, f, 
messages.elementAt(msgIdx) 
       .toString(), rowsLeft); 
    } 
   } 
 
  } 
 
  /** 
   * Assumes non empty message. 
   *  
   * @return used row count. 
   */ 
  private int drawMessage(Graphics g, Font f, String msg, 
int rowsLeft) { 
   int maxWidth = LcduiUI.this.getWidth(); 
   int begin = 0, end = 0; 
   int rows = getApproximationOfRowCount(f, msg); 
   for (int rowIdx = 0; rowIdx < rows; rowIdx++) { 
    for (; end <= msg.length() 
      && f.substringWidth(msg, begin, 
end - begin) < maxWidth; end++) 
     ; 
    end--; 
    g.drawSubstring(msg, begin, end - begin, 0, 
      (rowsLeft - rows + rowIdx) * 
f.getHeight(), 
      Graphics.TOP | Graphics.LEFT); 
    begin = end; 
   } 
   return rows; 
  } 
 
  private int getApproximationOfRowCount(Font f, String 
msg) { 
   int maxWidth = LcduiUI.this.getWidth(); 
   int strWidth = f.stringWidth(msg); 
   int rows = strWidth / maxWidth; 
   if ((strWidth % maxWidth) > 0) 
    rows++; 
   return rows; 
  } 
 
  public void refresh() { 
   repaint(); 
  } 
 } 
 

  



 class Message { 
  Date date; 
 
  String userName; 
 
  String msg; 
 
  Message(String userName, String msg) { 
   this.date = new Date(); 
   this.userName = userName; 
   this.msg = msg; 
  } 
 
  public String toString() { 
   if (userName == null) 
    return msg; 
 
   StringBuffer buf = new StringBuffer(); 
   buf.append(userName); 
   buf.append(": "); 
   buf.append(msg); 
   return buf.toString(); 
  } 
 } 
 
 private MIDlet midlet; 
 
 private Vector messages = new Vector(); 
 
 private ConnectionProtocol protocol; 
 
 private TextField field; 
 
 private MessageArea messageArea; 
 
 private Command send = new Command("Send message", 
Command.SCREEN, 1); 
 
 private Command log = new Command("Log screen", Command.SCREEN, 
2); 
 
 public LcduiUI(MIDlet m) { 
  super("Bluetooth Bus Info"); 
  this.midlet = m; 
 
  field = new TextField("Msg:", "Application Started", 128, 
TextField.ANY); 
  messageArea = new MessageArea("Message Area", 
field.getMinimumHeight()); 
 
  append(messageArea); 
  append(field); 
 
  addCommand(send); 
  addCommand(log); 
 
  setCommandListener(this); 
 } 
 
 public void chatMessage(String userName, String msg) { 
  messages.addElement(new Message(userName, msg)); 

  



  messageArea.refresh(); 
 } 
 
 public void chatLeave(String userName) { 
  messages.addElement(new Message(null, userName + " is 
leaving.")); 
  messageArea.refresh(); 
 } 
 
 public void chatEnter(String userName) { 
  messages.addElement(new Message(null, userName + " has 
joined.")); 
  messageArea.refresh(); 
 } 
 
 public void setCurrent() { 
  Display.getDisplay(midlet).setCurrent(this); 
  messageArea.refresh(); 
 } 
 
 public void setProtocol(ConnectionProtocol protocol) { 
  this.protocol = protocol; 
 } 
 
 public void commandAction(Command cmd, Displayable d) { 
  if (cmd == send) { 
   protocol.broadcastMessage(field.getString()); 
  } else if (cmd == log) { 
   Log.setCurrent(midlet); 
  } 
 
 } 
 
} 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  



/* 
 * Log.java 
 * 
 * Created on April 11, 2007, 3:58 PM 
 * 
 * To change this template, choose Tools | Template Manager 
 * and open the template in the editor. 
*/ 

package ui; 
 
import java.util.Vector; 
 
import javax.microedition.lcdui.Command; 
import javax.microedition.lcdui.CommandListener; 
import javax.microedition.lcdui.Display; 
import javax.microedition.lcdui.Displayable; 
import javax.microedition.lcdui.Form; 
import javax.microedition.lcdui.StringItem; 
import javax.microedition.midlet.MIDlet; 
 
public class Log extends Form implements CommandListener { 
 
 static private Log instance; 
 
 static Vector logs = new Vector(); 
 
 private MIDlet midlet; 
 
 private Displayable previous; 
 
 private Command back = new Command("Back", Command.BACK, 1); 
 
 private Command next = new Command("Next Page", Command.ITEM, 
2); 
 
 private Command prev = new Command("Prev. Page", Command.ITEM, 
2); 
 
 private int currentPage = 0; 
 
 static private int LINES_IN_PAGE = 5; 
 
 // private Command refresh = new Command("Refresh", 
Command.SCREEN, 1); 
 
 private Log() { 
  super("Log"); 
  addCommand(back); 
  // addCommand(refresh); 
  addCommand(prev); 
  addCommand(next); 
  setCommandListener(this); 
  instance = this; 
 } 
 
 public static void setCurrent(MIDlet midlet) { 
  if (instance == null) 
   instance = new Log(); 
 
  instance.midlet = midlet; 

 
 

  



  

 
  instance.previous = 
Display.getDisplay(midlet).getCurrent(); 
 
  Display.getDisplay(midlet).setCurrent(instance); 
 
  instance.refresh(); 
 } 
 
 public void commandAction(Command cmd, Displayable d) { 
  if (cmd == back) { 
   Display.getDisplay(midlet).setCurrent(previous); 
  } else if (cmd == prev) { 
   if (currentPage > 0) 
    currentPage--; 
   refresh(); 
  } else if (cmd == next) { 
   if (currentPage < getPages()) 
    currentPage++; 
   refresh(); 
  } 
 } 
 
 private int getPages() { 
  int pages = logs.size() / LINES_IN_PAGE; 
  return pages; 
 } 
 
 private void refresh() { 
  synchronized (logs) { 
   if (size() == 0) 
    append(new StringItem("", "")); 
 
   if (!(get(0) instanceof StringItem)) 
    return; 
 
   StringItem str = (StringItem) get(0); 
 
   StringBuffer sb = new StringBuffer(); 
   for (int i = currentPage * LINES_IN_PAGE; i < 
(currentPage + 1) 
     * LINES_IN_PAGE 
     && i < logs.size(); i++) { 
    sb.append(logs.elementAt(i).toString()); 
    sb.append("\n"); 
   } 
 
   sb.insert(0, "Page (" + currentPage + "/" + 
getPages() + "):\n"); 
   str.setText(sb.toString()); 
  } 
 } 
 
 static public void log(String string) { 
  logs.addElement(string); 
  System.out.println(string); 
 
  if (instance != null) 
   instance.refresh(); 
 } 
 



  

 static public void log(String location, Exception e) { 
  log(location); 
  log(e.getMessage()); 
  e.printStackTrace(); 
 } 
 
 static public void clear() { 
  logs.removeAllElements(); 
 } 
  
} 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



  

/* 
 * ServerThread.java 
 * 
 * Created on April 11, 2007, 3:57 PM 
 * 
 * To change this template, choose Tools | Template Manager 
 * and open the template in the editor. 
 */ 
 
package ui; 
 
import javax.bluetooth.LocalDevice; 
import javax.microedition.io.Connector; 
import javax.microedition.io.StreamConnectionNotifier; 
 
/** 
 * A class that acts as a server to wait for new Bluetooth 
connections. 
 */ 
public class ServerThread extends Thread { 
 
 private ConnectionProtocol protocol; 
 
 public ServerThread(ConnectionProtocol protocol) { 
  this.protocol = protocol; 
 } 
 
 public void run() { 
  try { 
   LocalDevice device = LocalDevice.getLocalDevice(); 
  
 device.setDiscoverable(BluetoothSettings.DISCOVERY_MODE); 
   String url = "btspp://localhost:" + 
BluetoothSettings.UUID 
     + ";name=ChatApplication"; 
 
   Log.log("Create server by uri: " + url); 
   StreamConnectionNotifier notifier = 
(StreamConnectionNotifier) Connector 
     .open(url); 
 
   while (true) { // infinite loop to accept 
connections. 
    Log.log("Waiting for connection..."); 
    protocol.handleServerConnection(new 
WorkaroundStreamConnection(notifier.acceptAndOpen())); 
   } 
  } catch (Exception e) { 
   Log.log("ServerThread-Exception", e); 
  } 
 } 
 
} 
 
 
 
 
 
 
 
/* 



  

 * WorkaroundStreamConnection.java 
 * 
 * Created on April 11, 2007, 3:56 PM 
 * 
 * To change this template, choose Tools | Template Manager 
 * and open the template in the editor. 
 */ 
 
package ui; 
 
import java.io.DataInputStream; 
import java.io.DataOutputStream; 
import java.io.IOException; 
import java.io.InputStream; 
import java.io.OutputStream; 
 
import javax.microedition.io.StreamConnection; 
 
/** 
 * A workaround class for S60 3rd edition and S80 devices. This class 
will slow 
 * down the stream. 
 *  
 */ 
public class WorkaroundStreamConnection extends Object implements 
  StreamConnection { 
 
 private static final int SLOW_DOWN = 150; // ms 
 
 private StreamConnection conn; 
 
 public WorkaroundStreamConnection(StreamConnection stream) { 
  this.conn = stream; 
 } 
 
 public InputStream openInputStream() throws IOException { 
  return new InputStream() { 
   InputStream in = conn.openInputStream(); 
 
   public synchronized int read() throws IOException { 
    int ret = -1; 
    while (true) { 
     ret = in.read(); 
     if (ret < 0) { 
      try { 
       Thread.sleep(SLOW_DOWN); 
      } catch (InterruptedException e) 
{ 
      } 
      continue; 
     } 
     break; 
    } 
    try { 
     Thread.sleep(SLOW_DOWN); 
    } catch (InterruptedException e) { 
    } 
    return ret; 
   } 
  }; 
 } 



  

 
 public DataInputStream openDataInputStream() throws IOException 
{ 
  return new DataInputStream(openInputStream()); 
 } 
 
 public void close() throws IOException { 
  conn.close(); 
 } 
 
 public OutputStream openOutputStream() throws IOException { 
  return new OutputStream() { 
   OutputStream out = conn.openOutputStream(); 
 
   public synchronized void write(int value) throws 
IOException { 
    out.write(value); 
    out.flush(); 
    try { 
     Thread.sleep(SLOW_DOWN); 
    } catch (InterruptedException e) { 
    } 
   } 
    
   public void flush() throws IOException { 
   } 
  }; 
 } 
 
 public DataOutputStream openDataOutputStream() throws 
IOException { 
  return new DataOutputStream(openOutputStream()); 
 } 
 
} 
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STEP TO DEVELOP MIDP PROGRAM IN NETBEANS 

IDE 5.5 
 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



  

Creating a MIDP Application Using the Visual Mobile Designer 

The NetBeans IDE provides a wizard that enables you to quickly create a 

MIDP project. When creating the project, you can choose to develop your application 

in the Visual Mobile Designer (VMD) or in the Source Code Editor. 

Using the Visual Mobile Designer gives you the ability to graphically plan out 

the flow of the application and design the screens the application will use. The 

designer automatically creates the code for the application.  

Creating a MIDP/CLDC Application  

1. Choose File > New Project (Ctrl-Shift-N). Under Categories, select Mobile. 

Under Projects, select Mobile Application and click Next. 

2. Enter MyHello in the Project Name field. Change the Project Location to any 

directory on your system. From now on, we will refer to this directory as 

$PROJECTHOME.  

3. Check the Set as Main Project and Create Hello MIDlet checkboxes (both are 

checked by default). Click Next.  

4. Leave the J2ME Wireless Toolkit as the selected Target Platform.  

5. Click Finish. The IDE creates the $PROJECTHOME/MyHello project folder. The 

project folder contains all of your sources and project metadata, such as the 

project Ant script. 

The application itself is displayed in the Flow Design window of the Visual 

Mobile Designer. 



  

 
 

Editing the Java Source Code 

Now let's edit the text displayed by the MIDlet. 

1. Click on Screen Design.  

This opens the Screen Designer window, and displays the helloForm[Form] 

screen, which is the only screen available in the application.  

2. Double-click on the "Hello world!" text and type in some new text.  

 

 

 



  

Compiling and Running the Project 

1. Choose Run > Run Main Project (F6) from the Run menu. Double-click the 

Output window to maximize it so you can see all the output. Note that the 

HelloMIDlet.java file is built before it is executed. A device emulator 

opens to display the results of the executed MIDlet. The default device 

emulator is DefaultColorPhone. 

2. In the device emulator window, click on the button below the Launch 

command. The device emulator launches the MIDlet and displays the text you 

entered in the source code.  

3. Click on the button below Exit to close the MIDlet. Then click on the button in 

the upper right corner of the device to close the emulator window.  

 
 
 


